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Journey to a land of Wizardry 
The Wizardry program is truly magical. It turns your Macintosh into a portal 
that can transport you to a time long ago, before Mankind turned to technology 
as the basis for Civilization. In the days of the Age of Magic, Men were Real 
Men, Women were Real Women, and everything else was Real Scared. The 
world was full of brave warriors, evil wizards and fearsome monsters. The good 
guys were really good; the bad guys were really bad; and the guys in-between 
were usually caught in the crossfire between the good guys and the bad guys! 

With the help of the Wizardry program, you will be able to create and captain a 
party of brave adventurers, who will explore a maze filled with great rewards 
and fearsome monsters. If the adventurers are brave, resourceful, and lucky, 
they may be able to find the lair of the evil wizard Werdna, defeat him, and 
return his amulet to their patron, Trebor. 

Characters 
Each character is a unique individual, with strengths, weaknesses, and special 
abilities. A character is described in the game by his Statistics, Characteristics, 
Possessions, Experience, and Class. 

Statistics are the basic measure of a character's ability to do things. The 
higher the statistic, the better the character's performance. 

• Strength affects your skill in combat. 

• l.Q. and Piety influence your ability to cast and resist spells. 

• Vitality affects your ability to withstand damage. 

• Agility helps you avoid attacks and open treasure chests. 

• Luck comes to your aid in many mysterious ways. 



Characteristics are the basic physical an~ emotional descriptions of you r 
character The most important 1s Race . Wizardry characters can belong to 
one of five races. Each race has different stre~g~hs and weaknesses, most 
visibly reflected in the minimum Ability values (stat1st1cs) for each Race. 

• Humans are jack-of-all-trades .characters. They e~cel at nothin9, but 
have no particular weaknesses, either, except for a decided lack of Piety. 

• Elves are intell igent and pious, but not very hardy. They make good 
spell casters. 

• Dwarves are strong and robust, and make excellent warriors. 

• Gnomes are pious and agile, probably from worshipping underground 
during earthquakes. They make excellent Priests. 

• Hobbits are agile and very, very lucky. They make excellent Thieves. 

Another important characteristic is Alignment , which describes you r 
character's general ethical outlook. 

• Good characters are really good. They go out of their way to help old 
ladies cross the street. 

• Neutral characters take life as it comes. They would help an old lady 
across the street if they also happened to need to cross it. 

• Evil characters are not really evil when compared to some of the things 
they fight in the Maze. They are self-centered, and always want to know 
"what's in it for them." Evil characters won't help old ladies across the 
street; young ladies, on the other hand, might be assisted. 

• Note: In the above, we are assuming the adventurer is male, as 
we may sometimes do in this Guidebook. Wizardry is, however, an 
Equal Opportunity Universe, where female adventurers are not only 
common, but have been known to help old men across the street! 

Of great importance to spell-casting characters are their Spell Books, which 
list which spells they are able to cast. These characters also have Spell 
Points, which may be used to cast the spells they know. 

Spells are divided into two broad categories; Magical and Priestly. Within 
each category there are 7 Levels of spells, from weak Level 1 spells to the 
powerful Level 7 spells. 

Other important characteristics include Hit Points, which describe how much 
damage a character can tolerate before death, and Armor Class, which 
describes how well protected the character is. 
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Possessions arE'. items, mu~da~E'. or magical, which the character has bought 
or fo.und. Gat~enng and maintaining the best possible possessions is a major 
pastime for Wizardry adventurers , as they can make the difference between 
life and death I 

Among the m~st i.mportant possessions of your character is Gold. When your 
character begins life, ~e has a small allowance, his ancestors' legacy -- barely 
enough to buy some s1mpl~ armer and a few paltry weapons. As your character 
explores the Ma~e . he will find great riches in gold, which may be used to 
purc~ase bette~ items, p~ocurE'. food and lodging, and perhaps occasionally 
acquire the services of a high priest to cure, heal, or even resurrect a friend . 

The num~er ~nd variety of ite.ms found in Wizardry, including weapons, armer, 
~nd magical items may be a little bewildering at first. We won't tell you how the 
items work, but do offer some general guidelines here. 

Not all magical ite.".ls may be used by every character. Some items may be 
used only by ~pec1f1c character classes. For example, Mages may use neither 
plate., nor chain armer, nor swords. You wil l learn what works by practice and 
experience. 

You never see most of the characteristics which define the behavior of items· 
rath.er, ~hese pror:ierties influe~ce the game in subtle and complex ways. To 
begin with, many items have alignment, as your characters do. Some items are 
Cursed, and cannnot be discarded without special magical assistance. 

~ursed items, h.owi::ver, are not the same as Evil items, although they may 
indeed be C?f .Evil alignment. You usually can't tell an item's alignment by its 
name; an~ 1f items and the characters equ ipped with them are incompatable, 
strange things may happen. 

Some items m~y be used to cast spells. These usually wear out after several 
use~. Some will evaporate upon their first use, while others may retain their 
magical "charge" forever. 

Cert?-in magic items. are associated with special powers which will only become 
~anifest when you invoke them. When you try to equip yourself with such an 
item, you will be asked if you wis:·: to invoke its power. 



. · f th haracter's mettle and abilities, as tested in th,e 
Experience is a meas~reA~T/ sc and Characteristics describe the characters 
Real ~orld. Whereh t be t ~~iye to measure the ability of a character to help the 
potential, perhaps t . e es . 
party is by his Experience Points. 

· · ·nts only through the test of steel, in real 
A charact~r can gain expenenceT~~1re and only there, can the character's 
comb~t with a mortal enedmy After each combat all surviving members of the 
potential be truly measure · . . ' 
party will receive a number of Experience Points. 

As the ~haracter gains experie~~eb~re~r~:h~erT~~~; ;~:~~ ~~~s~~ta?;~~.n$~u~ 
upon h;s <?las~d t~~i~et~~J1e the next Le~el. The charact~r·s l~vel affects the 
~~~r~\e~~~~aispell points available, fighting ability, and h1~ points. When a 
character makes level, he is able to do things better an~urv1ve longer. 

M'Lean 

All of a character's Abilities and Characteristics combine to help you determine 
his Class. A Character's class is a sort of job description. It describes what the 
character has trained himself to be. A character can only belong to one class at 
any time, although he can occasionally change to a new class. Each class has 

special restrictions as to Abilities, Alignment and Possessions, and the special 
training provided to class members gives unique and special abilities. The eight 
classes are: 

• FIGHTER: The basic man-at-arms. Fighters need 11 or more 
Strength points, and characteristically have high Hit Points. They can use 
any armor and weapons, and are reliable in combat. They may be of any 
alignment. 

• MAGE: The sorcerer. Mages need a minimum 1.0. of 11, and have 
poor hit points. They can use only daggers and staffs as weapons, and 
can wear no armor except for robes! They can use magical spells, 
however, and may be of any alignment. 

• PRIEST: The holy one. Priests have a minimum Piety of 11. They 
have fairly high hit points, and, although they cannot wear helmets, may 
use most any armor or shield. Priests do not fare as well in combat as 
Fighters, and must use specially consecrated weapons, such as maces 
and flails. Priests have unusual abilities, however: in addition to throwing 
priestly spells, they can Dispel! monsters. Priests may not be of Neutral 
alignment. 

·THIEF: The trickster. Thieves have at least 11 Agility points, and 
generally get better hit points than Mages do. Their weapons are daggers 
or short swords; they can wear leather armor and use a shield. Thieves 
are very good at circumventing the noxious traps which may lie between a 
party of adventurers and their hard-earned loot. They may not be of Good 
alignment. 

Ye basic aduenturers 



•BISHOP: A combination of Priest and Mage, with some advantages 
and disadvantages of both. Bishops have average hit points, c?n wear 
leather armor and use Priests' weapons. They use both magical and 
priestly spells: although they do. not learn them 8:S quic~ly as the other 
classes do. Bishops start learning Mage spells 1mmed1ately, but must 
reach the fourth level of ability before acquiring knowledge of Priest spells. 
Bishops are capable of identifying. ma9ical items, and ?O need not pay the 
hefty charge levied for that service m the Shop. Bishops may not be 
Neutral. 

• SAMURAI: These folk are fantastic warriors, and can use all Fighter 
weapons and armor. They start out life with more hit points than Fighters; 
in the long run, though, a Fighter will have better hit points. At the fourth 
level of ability, Samurai slowly begin to learn magical spells. They cannot 
be of Evil alignment. 

• LORD: A combination of Fighter and Priest. They have the hit points 
and abilities of Fighters, but at the fourth level of ability they gain the use of 
priestly spells, and the ability to Dispel!. Lords must be of Good alignment. 

• NINJA: A superhuman fighting machine. Ninjas can use any weapons 
or armor, but work best without any! When fighting with their bare hands 
they can wreak havoc and destruction, sometimes killing the strongest 
opponent with a single blow. Their great training gives them lower and 
lower Armor Class as they reach higher and higher levels of ability. 
However, they earn hit points as does a Thief, and gain no spells. Finally, 
they must be Evil. 

Ye elite aduenturers 
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Places 
Your adventurers spend th.eir time in one of two places. The Castle is a safe 
haven where they can tram, rest and lick their wounds, be ripped off by the 
shopkeeper, or. even resurrected from the Grave. The Maze is where the 
advent~rers go m search of monsters to kill, loot to "borrow", and clues to help 
dete.rf'!'\1ne the whe~eabouts of the Evil Wizard. As the characters become more 
prof1c1ent, they w.111 be able to adventure for longer periods of time, and 
pe~etrate d~eper into the Maze; eventually, they may come face to face with 
their nemesis, Werdna! 

The Mission 
Trebor, the ~ad Overlord, while undeniably mad is by no means stupid He 
~eeds ~o things to set in motion his master plan fo

1

r world domination. The first 
is an Elite Guard of t~e best characters of each class. The second is the magical 
Amulet stolen fr~m him by the Evil Wizard Werdna. Werdna is so EVIL that 
he helps ~Id ladies only half-vyay across the street. Then he steals their purses! 
Werdn~ 1s. known to mak.e his home somewhere in the Maze and to have the 
amulet in his hands at all times. ' 

Trebor, ".'ell k.nown for killing two bir~s with one stone (or any other handy 
weapon), 1s using t~e Maze as a Proving Grounds. He figures that this is the 
perfect place to train the elite group of adventurers he needs and possibly 
recover the amulet a~ the ~ame ~ime. Needless to say, any adventurers who 
recover the amulet will be 1mmed1ately inducted into his Elite Guard, by force if 
need be . .. 

T~is, then, is the situation your characters are thrust into. With a little luck they 
will map the Maze, ~aul the monsters, make off with the goodies, find the 
amulet and only get killed a few times while doing it! 



Getting Started 
· · re uires only the basic 128K Macintosh.wit~ on~ built-in dis,k 

~l?-yingi:!~~~~~~ to ~he Wizardry Master disket~e s~pplied in this box, you 11 
ar~~e.need a blank diskette to make .the Scenario disk. You must make a 
Scenario copy in order to play Wizardry. 

T make our scenario copy, you may use the Macintosh Disk Copy progr~m 
foound on ~ny MacWrite/MacP~int or simil~r disk. You ,may also copy the disk 
using the Finder, as described in your Macintosh Owners Manual. 

• WARNING: To protect yourself against mishaps. duri.ng the copying 
rocess, always be sure your Wizardry Mast~r dis~ 1:; wnte-protec~~d. A 

~rite-protected Macintosh disk is one whose little sliding tab 1s pos1t1oned 
so you can see a hole through the corner of the disk cover. Make sure you 
can see through the hole in the Master! 

The Castle 

Starting the Game 

You can start the game by turning on your Macintosh and inserting the 
Wizardry Scenario copy into the Internal disk drive. The program will load, and 
if you are using a 512K Mac, the data files will be loaded into memory to speed 
the game up. Then you will be asked to insert your Master disk for a moment. 
Normally, you must start each game with the Scenario disk, and insert the 
Master for verification when asked to do so. 

• It's possible to play a very limited demonstration version of Wizardry by 
simply reinserting the Scenario copy when you are asked to insert the 
Master. This will enable you to play the game, but without any opportunity 
to develop experienced characters or to venture beyond the first level of 
the Maze. 

• If you have a hard-disk drive, you can install Wizardry by copying the 
"Wiz Files" folder onto the hard disk. To start the game, simply double­
click on the Wizardry icon, which resembles a coat-of-arms. 

H )fr.[ @ 
BACKUP 

Wizardry Scenario Backup File 
Application Datafile 

"If all else fails, read the Manual!" 

We can't overemphasize the importance of the instructions given in this manual. 
It's possible to stumble through the game without reading it, but you'll probably 
be a lot happier if you sit down with this book in front of you as you explore each 
aspect of Wizardry. Studies conducted at an insignificant Midwestern 
university have shown that 99% of all computer users read software manuals 
only after they have become hopelessly lost. Please be one of the one percent 
who won't have to call us at 3AM to complain about losing their favorite 
characters ... because you read the manual! 

About software piracy 

The authors spent over a year and a half programming and testing Macintosh 
Wizardry. They stayed up long into the night, adding the extra features and 
making the little refinements that make it so much fun to play. The late night 
food bills from Howard Johnson's were astronomical! So please resist the 
temptation to give copies to your friends. 



The Wizardry desktop 
The Wizardry desktop consists of a set of Windows, Application Icons, and 
Menus . Two of the Windows contain your characters, which you move by 
dragging ; other win~ows are .used. during actual exp~ditions,; The Application 
icons represent various l?cat1ons in game; you can launch them by double­
clicking. The Menus provide dozens of features and shortcuts. 

Windows 
s File Edit Windows 

Party 

fr ed 

Wilma 

T~e two large windows you see are titled Party and Roster. The Roster 
window shows all the characters you've created and stored on the disk, except 
for those assembled in the Party window. The Party window shows those 
characters currently banded together to adventure. If a character icon is 
greyed, then the character is either seriously hurt or in the Maze. 

The Swag Bag is a convenient holding area, used while moving items among 
characters. 

Other windows, such as the Maze window, will appear when they are needed. 

Hil 

s File Edit 

Part 

6 Vitalit 
0/0/0/0/0/0/0 Priest 

0 Gold 

Honors Earned 
''ilii:!:!i!~~itii!W.M!i!'i!l:i!i!J 
<ll!H:i!!B'ii$.!il!iilli~'i!t~n1111H1• 

I~ the above illustration , several Character Information windows are 
d1spl~yed . These. furnish important information about each character, and 
contain buttons which are used to perform various actions. Character windows 
are opened by double-clicking on a character's icon, or by using the Windows 
menu. 



Application Icons 
The Application icons are markers for the important sites around the Castle. 
They include The Training Grounds, the Adventurer's Inn (Hotel), Boltac's 
Trading Post (Shop), The Temple of Cant, and the Maze. 

Tr•ining Hotel Shop Temple Maze 

• In the Training Grounds you may create new characters and retire 
weary ones. 

• The Hotel is where characters rest, allowing them to regain lost hit­
points, receive credit for higher experience levels, learn new spells, 
celebrate birthdays, or be elected Guildmaster. 

• The Shop buys and sells items of value to adventurers, and can identify 
or uncurse some of the trickier ones. 

·The Temple is the place to take dead or severely injured characters. 
The priests of Cant can perform miracles for a modest donation. 

·The Maze is the area where your adventure unfolds. It is big and 
dangerous, but full of valuable things that your adventurers will covet. 

The Aduenturer's Inn (Visa, Mordorcharge accepted) 

Menus 
The seven menus provide nearly 50 features and shortcuts. 

• The a Menu contains several options, as well as desk accessories. 

•The File menu controls all disk and printer-related game functions. 

•The Edit menu holds the familiar "Undo/CuUCopy/Paste/Clear" items. 

•The Windows menu lets you manipulate the game's windows. 

•The Options menu contains many useful options and conveniences. 

•The Utilities menu contains three important game utilities. 

•The Help menu displays Sir-tech's address and hot-line phone number. 

More complete information on each of these menus can be found in the 
Appendix at the end of the manual. 



The Castle 
The Castle encompasses four locations wh ich provide special services to the 
Wizardry player. These are the Training Grounds, the Hotel, the Shop and 
the Temple. Each location is entered by double-clicking on its icon, just as you 
would do to launch an application in the Finder. 

~ HI<~ Edit Windows 

Swa 

Party 

Welcome to the Training Grounds. 
Enter the name of the character you wish to 
create or retire. 

Character name I Your Name Here 

[ Cancel 

([ Continue 

After selecting a locatibn, you 'll be asked which character you wish to take there. 
Enter the name of the character and press [Return] or [Enter] . If you have 
selecte~ a character in the party or the Roster by clicking on it, that character's 
name will have been entered and selected for you , so all you need do is press 
[Return] or [Enter] . 

As a special s_hortcut, you can simply drag the icon of the selected character on 
top of t~e desired location icon (which will invert) and release the mouse button. 
This will launch the ~pplication an~ enter the character automatically. To 
prev~nt you from accidentally deleting a character, however, you will not be 
permitted to enter the Training Grounds by this method. 

Often you will wan_t to t_ake all ~f your party members to either the Hotel or the 
Shop. To make this a little easier, when any character who is a member of the 
party le!'lves one of !hes~ locations, the launch-and-entry process will 
automat1cal_ly start ag~in . with the next character in the party selected for you. 
To break this cycle, click on the Cancel button . Otherwise, it will continue until 
the last party member has been accomodated. 

qnce you hav~ selected a character each location will provide its own unique 
displays and d1alogs, as explained below. 

• NOTE: In describing these features, it will sometimes be necessary for 
u~ to use !erms that may be un_familiar to you . Don't panic! These terms 
will be defined later o~ . usually in the Adventuring section. If curiosity gets 
the better of you, a quick perusal of the Appendices will help. 

Wizardry Map 

Trainittg 
Grounds 



The Training Grounds 
The Training Grounds lets you create new, novice characters, and retire old, 
world-weary adventurers. If you e~tere~ the nan:ie of a cha~acter that already 
exists Wizardry will prepare to retire him, but will ask yo~. iust to make sure. 
Retired characters pack up all their belongings, go to Sun City, and are deleted 
forever from the game. If, on the other hand, you enter the name of a 
character that does not yet exist, you'll be able to create a new one. 

• fll<~ I: di1 Windows 

Party 

Choose a Race and Alignment for Fred. Race 
determines the basic capabilities of the 
character. Alignment determines what 
classes he/she may become. 

®Human 
Swa 0 Elf 

O Dwarf 
QGnome 
0 Hobbit 

A Star is Born 

@Good 
O Neutral 
0 Evil 

[ Cancel 

U Continue 

Once you have chosen the new character's name, you will see a new dialog 
box, in which you must choose his Race and Alignment. 

In looking at the Race and Alignment dialog box, note that the sel~ctions 
Human and Good are made for you initially. You can ma~e ot~e:r select19ns by 
clicking on the buttons next to each choice. When you re finished, click on 
Continue to proceed. 

Now you see another dialog box, listing the character's Statistics. Your 
character will fit into one of the eight Classes on the basis of these Statistics. A 
set of minimum statistic values are established for each race, and you have a 
chance to influence the class of your characters by distributing Bonus points. 

• HIH l:di1 UHndows 

Party 

Swa 

Use the Bonus points to qualify for a class. 
When all the points are used, select a class 
and click Create. 

1:2:1 
~ 
Mage 

8 
5 
8 
8 
9 

D LJj 
Priest 

!Bonus 71 

Cancel 

Thief Bishop Samurai 

Note that a special space in the dialog box tells you how many Bonus points 
you have to work with. The number of Bonus points is selected randomly each 
time you create a character. You'll distribute these points among the various 
Statistics by using the scroll bars next to each. 

The minimum number of points for each statistic is determined by the 
character's race. The maximum number of points available is limited tn two 
ways. First, the maximum value of a statistic is 18. Second, you can only 
increase statistics when you have some Bonus points left to play with. 

• You can change the statistics any way you like, but you must use up all 
the Bonus points you've been given. 



~ HI <~ I: dl1 UJin dO UJS 

Swa 

Party 

Use the Bonus points to qualify for a class. 
When all the points are used, select a class 
and click Create. 

Strength 11 !Bonus ol 
I.Q. 11 
Piety 5 
Vitality 9 
Agility a 
Luck 9 

Mage 

m 
LJj 
Priest Thief 

Create 

Cancel 

Bishop S~murai 

When you make certain changes in the statistics, some of the class icons at the 
bottom of the dialog box will change from being grayed out to being normal in 
appearance. For instance, the Fighter icon becomes normal as soon as the 
number of Strength points reaches 11. The Mage icon becomes normal when 
1.0. reaches 11. Class icons may be selected whenever they're not grayed out. 
Once you've picked a class and used up all your bonus points, you can click on 
Create and voila! A new adventurer emerges full-grown! 

An act of the gods? 

The Hotel 
After a hard day in the dungeon, every adventurer looks forward to a refreshing 
stay in a first-class hotel. Unfortunately, there is nothing remotely resembling a 
first-class hotel in the Castle, so weary travellers have to settle for the 
Adventurer's Inn. 

The Adventurer's Inn offers several important amenites for your characters. To 
begin with, staying in the Hotel overnight or longer can help you recuperate from 
rough fights with monsters by restoring some or all of the hit points you've lost in 
combat. If you've accumulated enough experience points to qualify you for a 
higher experience level , checking into the Hotel will let you learn of your 
succes~ . and provide details about the changes in your character statistics. 
9therw1se, you 'll be told how many more experience points you need to 
increase your level. Finally, the changes in your character statistics may enable 
you to change from one character class to another, and the Hotel has a special 
facility for th is purpose. 

• As you'll soon discover, certain spells can also be thrown on your 
characters which will restore hit points without the trouble and expense of 
visiting the Hotel. But the Hotel provides such medical services even to 
those without spell-casting friends, as long as you have the cash . 

Once you've checked a character into the Hotel , you'll be able to look over the 
types of rooms available. The more expensive rooms provide faster, but less 
economical, healing powers. 

•Note: Age is important in Wizardry. Beyond the age of 50, you will 
become more and more feeble, until eventually you will not be good for 
much of anything except chatting about the "good old days" before the 
invention of the wheel. Therefore, you do not want to spend too many 
weeks in bed . . . 



• fil<~ I' di1 11Jinl1ows 

Party 

Welcome, Fred. You haue 1 87 Gp. What room 
do you desire? 

The Stables (free) Priuate Room 

swa 
The Barracks Royal Suite 

Double Occupancy Pool Gold 

Check Out 

Resting up 

Click on one of the room types, or on the Check Out button if you've changed 
your mind. Each type restores Hit points in return for a weekly fee. 

Stables 
Barracks 

Double Occupancy 
Private Room 

Royal Suite 

Hit Points/week Fee/week 
none 

1 
3 
7 
10 

none 
10 
50 

200 
500 

Need more money? You can also Pool Gold from your party. This strips all the 
other party members of all their gold, and gives it to the character in the Hotel. 

• If all of the room types except the Stables are grayed out, you don't 
need to rest. Either Check Out or stay overnight in the Stables to find out 
whether you made a level. 

Once. y~u·ve chosen a room, you must decide whether to stay One Week, or to 
remain in bed Until Healed or Penniless, whichever comes first. After your 
stay, you'll learn if you celebrated your birthday or made a level. 
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Party 

Betty 

Swa 

Making a level 

You haue attained the neHt leuel of 
eHperience. 

You gained Strength. It is now 12. 
You gained 1.0. It is now 12. 
You gained Piety. It is now 6. 
You gained Uitality. It is now 11. 
You gained Agility. It Is now 9. 
You haue gained 1 hit point. 

H Continue 

Making a level is a joyous occasion. You'll see a declaration that "You have 
attained the next level of experience," and get all the news about the changes to 
your character statistics. Spell-casting characters may learn new spells. At the 
end of this sequence, you'll learn how far away the next experience level is. 

• Your spell points are automatically replenished each time you enter or 
leave the Maze. But only a paid visit to the Inn lets you learn new spells. 

Th~re's a chance xo!-1, might qualify f.or mC?re than one level per visit to the Inn. 
This could happen 1f 1t s been a long time since you've had a good night's rest. If 
so, the entire "level" message process will be repeated. 
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Party 

~ 
llZll 

If you wish to change class, select your new 
class below. To remain a Fighter, click Don't 
Change. 

IT] '--_D_o_n'_t_C_h_a_n_ge_~] [...___c_t1_<1r~H~J<_l _C_l<1_~_s_~ 
Betty 

Swa 

Mage Priest 

Bishop Samurai Lord Ninja 

Changing class 

Sometimes, attaining a higher experience level will change your character 
statistics enough to qualify you to Chan9e class. If this is the case, a special 
dialog box will appear, reminding you which class you're now in, and displaying 
the seven other character-class icons. Icons which are greyed represent 
classes for which you do not qualify. To change class, click on the icon of the 
desired class and then click the Change class button. 

When you change class, you are entering a new category of being at the 
ground level. Therefore, changing class has the following side-effects: 
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•All your equipment will remain in your possession, but your items will be 
Un Equipped. 

•The number of your experience points goes to zero. 

·You begin at Level 1 in your new class. 

·You may not have as many spell points. 

•Your character statistics drop to the minimum for your race. 

The Shop 
The commercial center of the Castle is owned and operated by a friendly dwarf 
named Boltac. Like all dwarves, Boltac likes gold, and will sell you your own 
arms (not your "armaments," your arms!) if he can get away with it. 

Once you've brought a character into the Trading Post, using the methods we 
talked about earlier, the Shop window will appear. 

• nl<l t:di1 Windows 

~ 
llZll 

IT] 
Betty 

Swa 

Party 

~ Please feel free to browse, Barney. 

jGold ~-----1_78~1 [ Buq 

. -
Long Sword O 

[ IJncur~•~ ] Flail HHH 

[Pool Gold] 1-::~,,...:....,:gf.,..1'~-rS-h-ie-ld----1~1 
Leaue ] Large Shield 0 

This single window contains all the information you need to make Boltac's 
Trading Post your One-Stop Shopping Center. The box labeled Gold tells you 
how many gold pieces you possess. On the left is the box where the list of items 
you own will appear. On the right, the Shop's inventory is displayed in a box with 
a scroll bar. In the center of the window are buttons allowing you to: 

• Buy, Sell, and Identify items. 

• Uncurse cursed items. 

• Pool Gold from all party members into your possession. 

• Leave the Shop. 
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There is one additional box in the window, which appears. when you've selected 
an item ou wish to Buy, Sell, Identify or Uncur~e . . This tells you ~ow. much 
you will 6e paid for the selecte~ item if you are selling 1t, or how much 1t will cost 
you to buy, identify or uncurse 1t. 

• HI<~ Edi1 UJintiows 

Party 

~ ~ llD 
Please feel free to browse, Fred. 

rn !Gold =:..:::.... ___ __:l-'-7~8 I I Buy I L.=IB:..::u:Ly...:f..:.;or=--------'l-'-0_.0 I 

Betty . -
Lame Shield 

Swa ~::.:.::::.:.:....:=;.:.;;;.---1 11 d<m1i1'lJ I ~~;.;;.~.;;.~~,;.;s;...e_r -A-rm-or----1~! 
I 1Jncun1~ I i.:C:..:h.:::ai:.:.:n...:M.:..::a;;;;i;.;;..l ___ -t _J 

:P•::~::lll: !:~~:~:~:!~!~!::~te~~~~~~!!~l'!1 

Buying Items 

Boltac has an enviable inventory, but he may sometimes run. out of certain 
items. Other items won't turn up in the Shop unless som~one brings t~em back 
from the depths of the Maze, and sells them to the proprietor. So the inventory 
list may change in length and content as the game progresses. 

To buy an item, browse through Boltac's wares by usi.ng the scroll bar, then click 
on the item you want. You'll be told how much 1t costs, and whether the 
character can use it. If you still want it, click on Buy. 

• CAUTION: After leaving the store, you will proba~ly be ~slighted with 
your shiny new items. But be aware that merely. owning. an 1te.m does not 
enable you to use it in the Maze. Only those items with which you are 
Equipped can be called into play during combat. 

• HI<~ E di1 UJinliows 

Party 

~ ~ llD 
Please feel free to browse, Fred. 

[f] !Gold i.::...:..:..:::..._ ____ _:7~8 I ( HUIJ ] L.:I S:..::e:..:11...:.f o.:..:r;__ ____ l_O_.O I 
Betty Sell . -

Lame Shield 
Swa ( l<l<m1ifH ) Robes 

Leather Armor 
~,;;.,;.;;..._ ___ --1iiilil 

( IJncur~•~ ) Chain Mail 
Breast Plate 

(1>001 1;0111) Plate Mail 
Helm 

L,:...:.::..::....:..:..:.::.:.:;... __ --f, 
Leaue ~ofCurinl1' 

Selling Items 

Selling off excess equipment is a good way to raise cash for impoverished 
expeditions. Be aware, however, that Boltac is accustomed to making a tidy 
profit on every transaction, even those which involve buying back what he just 
sold you ten minutes before. 

Just click on the item you wish to sell off. You will be told how much Boltac will 
offer you. If it is acceptable, click on Sell. Items are UnEquipped when you 
sell them. 

• Note: You cannot sell an item that is Cursed or which needs to be 
Identified. 

Removing Curses 

Cursed items picked up in the Maze are denoted by a small c next to the name 
of the item. These items are very uncooperative, and they stick like glue to 
anyone who equips them. If you manage to get back to the Trading Post in one 
piece carrying such an item, Boltac can Uncurse it for you. Simply click on the 
item, curse at the unreasonable price Boltac quotes, then click on Uncurse. 
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Identifying Items 

When you first find certain items in the Maze -- signified by a small ? next to the 
item's name -- you cannot be _certain of their exact properties .. The names of 
these items describe only their appearance. Whenever possible, have such 
items Identified before you Equip yourself with them, in case they turn out to 
be Cursed. 

One of the special powers of the Bishop is !he abili~y to id_entify items_. However, 
there are some risks associated with having a B1sh_op inspect !3-n item. _If th_e 
Bishop is not very careful, he or she may touch the item by accident. . This w!ll 
cause the item to be Equipped, and if the item is Cursed, the hapless Bishop will 
be forced to use it. For this reason , Boltac has begun to perform such 
inspections himself. Unlike a Bishop, who lives to serve, Boltac exacts a fee for 
this service. 

The procedure for Identifying items is similar to that of Uncursing them, except 
that you must click on the Identify button instead. 

Pooling Gold 

Since few adventurers can qualify for a Dungeon Express Card™, the Shop 
features a Pool Gold button to help bring big-ticket items within reach of those 
on a limited budget. Again, this option transfers only the gold possessed by 
party members to the account of the person shopping. 

M'Leon 
Welcome . . . noble customers! 

The Temple of Cant 
Whenever a party brings back characters who are Dead , Paralyzed , or 
sim ilarly distressed, they can be carried to the Temple of Cant. The sole 
exceptions to this pol icy are Poisoned characters, who can either get well on 
their own or be cured by a magical spell , and folks who are Lost forever, who 
are automatically buried, mourned, and forgotten. 

s File t: di1 Windows 

Barney 

Betty 

Swa 

Party 

Will the party help pay the SOO Gp tithe the 
temple will requi r e? 

R No 

Enter the Temple in the normal fashion. If the high priests of the Temple can do 
anything to help the poor devil you 've hauled in , they will tell you what donation 
is required. But since the fees expected by the clergy are rather high these 
days, the afflicted person may not be able to afford the donation. Should the 
character not have enough gold, the entire party may be asked if they wish to 
tithe. This is not a voluntary contribution. 

Unless the victim is Dead or blown to Ashes, the healing arts of the Temple 
practitioners are assured of success. In serious cases, there is a chance that 
the best efforts of the priests will be to no avail! 
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A good Vitality ratinQ usually means that the Temple will suc?eed, but 9ld, infirm 
characters may be in big trouble. Dead characters who fail to be raised from 
the dead are reduced to Ashes. Even in such depressing circumstances, 
though there is still hope: for a larger fee, it is sometimes possible to resurrect a 
person' even from an ashen mess -- but if this attempt fails, the character is Lost 
forever, and cannot be restored by any means. 

Anyone brought back from the Dead will have but a single hit point, and should 
limp post-haste to the Hotel. Those resurrected from their Ashes will have all 
their hit points restored. 

THISWEEk 
ONLY~! 

1HEDEAD 
PA1SED1 

@@~~o 

M'Lwn 

The year-end clearance sale 

Quitting the Game 
Whenev~r you wish to stop playing, simply select Quit from the File menu, or 
double-click on the Quit icon, which you will find hidden underneath the Roster 
window. 

·WARNING: Any articles left in the Swag Bag will vanish if you quit. 

If you quit during an expedition, your party will be left in the Maze, and all data 
about the party's condition will be stored on the Scenario disk. When you 
resume the game, you'll find the characters you left OUT in the Maze in the 
Roster win~~.w, looking pale and tired. You can choose Restart a Party ... 
from the Ut1ht1e~ menu to return the entire party to its last known position in the 
Maze. Alternatively, you may bring other characters down into the Maze to pick 
up OUT adventurers. If you do so, remember to leave some room in the rescue 
party for them. 



Adventuring 
The heart of Wizardry is Adventuring. It's time to accept the challenge: . . time 
to leave the safe, but expensive, confines of the Castle, and venture into the 
unsafe, but potentially lucrative, corridors of the Maze. 

Successful adventures consist of four stages: 

• Preparing the Party for the adventure. 

·Touring and Mapping the Maze. 

• Fighting the monsters. 

• Getting back alive . 

The Party 
A party is a team of adventurers who band together to explore the Maze. You 
can have up to six characters in your party at one time. 

Characters created in the Train ing Grounds appear in the Roster window. To 
assemble a party, drag character icons from the Roster into the Party window, 
one character at a time, just as you would move files around using the Finder. 
Only characters in the Castle may be added to the party. If you wish to resume 
an .expedition that was left in the Maze, use the Restart a party ... menu 
option. 

• Balance your party. When first starting out, try a party of two Fighters, a 
Priest, a Thief, and two Mages. This is the strongest party you can make 
using characters with low experience levels. 

• Good characters will refuse to cooperate with Evil ones; if you try to put 
them together, you'll hear loud complaints. 

• Dead or otherwise incapacitated characters can be added to the party, 
although you will be asked if you really want to do this. 

Once you have placed the desired characters in the party, it is very important 
that you establish the best strategic arrangement for them. Re-order the party 
so that the best fighters are in the front, and the spell-casters are in the back. 
Do this by dragging characters to the Party-window positions you feel are most 
appropriate for them. When you drag one character icon on top of another, the 
character underneath will shift to the nearest open position. 

• If you're using the full complement of six party members, the upper 
positions in the window are numbered "first" through "third," and the lower 
positions are "fourth" through "sixth." 

Removing characters from the party is a simple matter: just drag them back to 
the Roster window. To break up a party in a hurry, you can select Disband 
party from the Options menu, which will move all the characters back to the 
Roster at once. 



s File Edit 

Part 

The Character Information Window 

Before you enter the Maze, it is usually a 9ood idea ~o check the "v!tal statist~cs" 
of each character in your party. You can inspect their Cha_racter 1nformat1_on 
windows by double-clicking on the appropriate character icons, or by selecting 
options from the Windows menu. 

This window offers a wealth of facts about your character. Five pie~es of 
information are found in the title bar. Your character Name, and Experience 
Level, appear first. Next are Alignment (Good, Evil, or Neutral), Race and 
Class. 

The title bar will also tell you about any problems you may have. Being DEAD is 
one of these, although you'll also see other terms here. Characters. who are 
marked OUT are somewhere in the Maze! Characters become OUT m one of 
three ways: because their entire party was killed, because of a power failure 
during play, or because you Quit the game while in the Ma~e. OUT chara.c.t~rs 
can be retrieved. Either select the Restart a party option from the Ut1llt1es 
menu, or send a small party down into the Maze to pick them up. 

• Icons of Dead, Disabled and OUT characters will be greyed out. 
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In the top half of the window, information about your Hit Points, Armor Class, 
statistics, Gold, Experience and Spell points appears. 

• Your character's Hit Points and Maximum Hits are displayed. Hit 
Points describes the amount of damage you can tolerate before death. 
Max Hits is the maximum number of hit points fou can have. Each time 
you are injured in combat, a certain number o hit points are deducted. 
They can be regained by resting in the Hotel, or by means of a magical 
spell, potion, or item. 

• Armor <?lass is a measure of how well-protected you are against 
~ttack . Thi~ . measure takes your equipment into consideration, and also 
involves Ag1l1ty and other secret factors. Note that, unlike other measures 
in this game, a better Armor Class, or AC, corresponds to a lower number, 
and AC may be expressed as a negative number if it is unusually good. 
Bare skin, for example, has an AC of 1 o. A Sherman Tank has an AC of 
about -1 o. 

·Strength, 1.0., Piety, Vitality, Agility and Luck are the character's 
basic statistics. 

• Shown next are your Mage and Priest Spell Points. These strings of 
numbers tell you how many spells of each spell level you can cast. 
Within each spell category, Mage and Priest, there are seven power 
levels. You can throw one spell, of a given type and power level, for each 
spell point you have in that slot. For example, Mage spell points of 
5/3/2/0/0/0/0 would mean that you can cast five first-level, three second­
level, and two third-level Mage spells. 

• Experience points (abbreviated Exp.) are awarded for killing 
monsters. Whenever a party defeats a group of monsters in combat each 
survivor earns experience points. When the total for your character 
reaches a certain value, you qualify for the next level of ability. 

• Gold gives you an instant read-out on your character's bank account. 
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The bottom half of the window is split into three sections: two columns of 
buttons, and an information panel. 

The information panel displays the character's Items, Spell Books, and 
Honers. The rightmost column of buttons controls the information panel 
display. 

• Clicking on the Items button will display the list of items you own. Each 
character can have up to eight items at a time. To the left of each item's 
name may appear a small letter that denotes its status. 

•An E indicates that the item is Equipped. This is explained below. 

•A ? indicates that the item is not identified, which means you don't 
know exactly what it is. 

•Ac indicates that the item is Cursed. Since it is stuck to you, and 
probably doing you more harm than good, a trip to the Shop to 
remove it may be in order. 

• The Mage Spells and Priest Spells buttons display the Spell Books. 
One level of spells is displayed at a time, on a single "page." Spells that 
the character does not know are greyed out. Both spell points and spell 
knowledge may change, at different rates, as your characters' abilities 
develop. 

• Next Level and Previous Level adjust which spell level is being 
displayed. These buttons are active only when you're looking at spells. 

•The Honers Earned button displays the honers that your character 
has been awarded, if any. 

l 
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The left-hand column of buttons controls actions that the character can perform. 
To use them, you first select an item or spell in the information panel , and then 
click on the desired button. 

• Give Item moves the selected item from the character's possession 
into the Swag Bag. 

• Take Item takes an item from the Swag Bag and places it in the item 
list. You must first select an item in the Swag Bag by clicking on it. 

• Party members can only use weapons, or be protected by armer, with 
which they are Equipped. (Un)Equip Item equips the character with an 
item selected from the list if it is not yet equipped, and "un-equips" it if it is 
already equipped. 

• Items fall into certain categories (weapons, armer, shields, etc.). 
Only one item from each category may be equipped by a character 
at a given time. 

•REMEMBER: Weapons and Armor you possess, but have not 
equipped, will not be of any use to you in combat. 

• Identify Item allows Bishops to attempt to identify an unknown item. If 
they fail, there is a chance they will be forced to equip it; and if it is Cursed, 
they may be in trouble! 

• Cast Spell casts the selected spell. When you select a spell from your 
spell books, you must have an appropriate spell point available in order to 
cast it. If you select a spell-casting Item, it may break during use. 

• Pool Gold moves all the party's gold to the character. If you later need 
to give back some gold to other party members, choose Divvy gold from 
the Options menu. 



Keyboard Window Commands 

There are simple keyboard equivalents for most of the buttons appearing in the 
character information window. In general, you may type the initial letter of the 
label on any button to activate that button. For example, pressing [M] is 
equivalent to clicking the Mage Spells button. The exceptions are: 

•Typing [+] activates the Next Level button. 

• Typing [-] activates the Prev Level button. 

• The Pool Gold and Identify buttons have no keyboard equivalents. 

Pressing a numeral key while looking at the Items list will select one of the 
items. Pressing a nu~eral key. while looking at ~ither Mage or Priest spells will 
s~lect a spell level. Finally, typing a numeral while holding down the [Shift] key 
will ~elect a spell from wh<l;tever page of sp.ells is displayed. For example, typing 
[Shift] [2] while Level 1 Pnest Spells are displayed will select DIOS, the second 
spell on that page. 

The Pre-Fight Checklist 

After you h~.ve arrang~d a group of characters in the party, but before you enter 
the Ma~e, !t s a good 1de~ to . make sure that everyone is well-prepared. Bring 
out their windows (xA will bnng them all out at once and arrange them nicely) 
and carefully look them over. 

• If anyone .is without full hit points, a stay in the Hotel is advisable. You 
may also wish to do this if you think anyone is ready to gain a level. 

• Characters who are incapacitated should be attended to in the Temple. 

• If you have some extra gold, a trip to the Shop might be warranted. 

• ~ake sure that each character is equipped with the right items. That 
shiny new sword you just bought is nothing but ballast unless you tell your 
character to use it! 

• ~very so often (especially after your characters make new levels) you 
might want to use the Print character reference sheets ... feature so 
that you can have something to refer to (or crumple in anguish) during 
combat. 

A"MOI<, CLASS , 10 Ar\MOr<- CLASS ' -10 

Wh y armor class is important 
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Touring the Maze 

s File Edi1 Windows Options IHHith~ s Help 

Party 

Fred Barney Bam Bam 

E~te:r the Maze just .as you would enter any other Castle location, by double­
cl1cking on t.he Maze icon. The Roster window will disappear and be replaced by 
the Maze window, and your party will move down the stairs into the Maze. 

The Maze wind~w displays a 30 "'.iew of the Maze passageways directly in front 
of yo~. ~y moving thfl_mouse pointer onto the Maze window, you can indicate 
th.e direction you .w~nt to move in. The pointer changes in different areas of the 
w!n~ow .. When 1t 1s near the center, it will be a forward-pointing arrow, and 
cl~cking will move you forward. When it is on the left or right side of the window it 
"".Ill b~come a left- or right-pointing arrow, and clicking will turn you go· in that 
d1rect1on. You can also move using a cluster of keys instead of the mouse. 

• [W] moves you one step forward. 

• [A] turns you go· left. 

• [D] turns you go· right. 

• [XJ turns you 1 ao· about. 

As you travel through the Maze, you will occasionally find unusual markings. 
These can represent stairs upwards and downwards, special passageways you 
might want to explore, and dark areas into which you cannot see. If you like, you 
can select the Mark location option, specially marking one square of the 
Maze. Besides keeping you from getting lost, this mark may aid you in mapping 
the Maze. 

Mapping 
Each time you enter the Maze, a dialog box tells you that you are at the foot of 
the staircase which links the Castle with the first (topmost) Maze level. If you go 
up these stairs, you'll be back in the Castle. 

•You have just entered the Maze, and you see the dialog box described 
above. You always start on the first level, as far South and as far West in 
the Maze as you can be, facing North. 

You may ask, WHO CARES? Well, in order to survive in the Maze, you must 
know with reasonable certainty WHERE YOU ARE and HOW YOU GOT THERE. 
The only way to know these th ings is to make accurate MAPS, and refine them 
every chance you get! 

Mapping is, indeed, one of the most important skills that successful Wizardry 
players possess. Without good maps, you will get hopelessly lost, and 
eventually your characters will die! Mapping is not all that difficult, but it does 
take a little patience and practice. 

Grab some of the MAP PLOTTING AID paper from the Wizardry box. Use this, 
or other graph paper, to chart your progress in the Maze. Be wary of nasty tricks 
designed to create inaccurate maps. 

For your first few expeditions we recommend that you avoid monsters by 
running away from them, until you have become comfortable with mapping and 
with getting out of the Maze quickly when you have to. 



Combat 
Without some sort of challenge, Wizardry would just be a game of mapping. 
You will soon learn to be grateful to a particular group of individuals for providing 
this challenge. After all, who gathers together all the loot in the Maze so that 
your characters can find it in nice tidy packages? Who gives bloodthirsty 
adventurers something to look forward to? Who blasts ill-prepared party 
members to smithereens? This is the life-work of Monsters. Mastering the 
fighting techniques described here will help you make their job less rewarding. 

Edit Windows 

Party Status 

Run 

Meet the Monsters 

Fred 
Barney 

Bam Bam 
Betty 

Wilma 
Pebbles 

Fighting 
Fighting 
Fighting 
Avoiding 
Avoiding 
Avoiding 

Attack 

As your party i~ moving through the Maze, it may encounter a group of 
monster~ guarding hoards of treasure. The monsters could be wandering 
around like you, or they may be inhabitants of a room you have just entered. 
Although .some monsters are peace-loving vegetarians, the majority of them 
really do hke the taste of a good "leg of adventurer," so it is likely that a fight will 
take place. 

When you encounter hostile monsters, your party goes on full alert. The 
character, Party and Maze windows will disappear, and three Combat Action 
windows will be created. To remind you that you are fighting for your life, the 
arrow pointer will change to a little sword. 

The first window, Party Status, gives a quick summary of each party member's 
condition, giving the name, current hit points and maximum hits for each person. 
If the character is incapacitated, then a description of his or her disability 
replaces the hit-points data. Poisoned characters are denoted by a small p. 

The second window, Monsters, lets you know whom you are fighting. You can 
be opposed by up to four groups of monsters, with up to nine monsters in each 
group. You'll learn the number of monsters in each group, what each appears 
to be, and in parentheses, how many are currently able to fight. Each monster 
group is also represented by an icon in the bottom of the window. If they have a 
treasure chest, its icon will also be displayed. 

The last window, Events & Instructions, will display the results of each round 
of fighting and spell-casting, giving you a blow-by-blow account of the combat. 
More importantly, this window is also the dialog box in which you enter your 
characters' actions. 

Combat encounters consist of series of rounds, which continue until either all 
the monsters have died or run away, your party manages to escape, or your 
entire party is slaughtered. 

At the beginning of each round, you will have to decide whether to stand and 
fight ("stay the course"), or run away ("behave rationally"). To attempt to evade 
the monsters, click on the Run button. If you succeed, you'll take one step 
backwards and the combat will be over. 

Should your efforts to escape fail, however, your opponents will attack before 
you've had time to select a strategy against them. You will then have to watch 
helplessly while the monsters clobber you for one round. 

• NOTE: Only the first three characters in the Party Status window can 
physically attack the monsters. By the same token, the only party 
members who can suffer damage from a physical attack are the first three 
characters. Monsters may cast spells, however, on any or all members of 
the party. Should one of your characters die in combat, he or she will 
automatically be shifted to the "dead-last" position in the party as soon as 
the dust has settled. The deceased will be hauled around by the living 
adventurers until being revived or removed from the party. This will mean, 
of course, that the party member previously in fourth place will move up to 
the number-three slot, rendering him or her vulnerable to attack. This 
character will be able to fight, as well, with whatever weapons come to 
hand. Keep this in mind when organizing your party. 



If you decide to stand and fight, you must then .determine what each char~cter 
will do. Next to each party member's n~me 1n the ~vents & ~nstruct1ons 
window is a text box where you'l.1 choose his or her a~t1on: Assuming that there 
are six active characters the first three characters actions will be preset to 
Fighting monsters, and.the second three to Avoiding them, at the start of 
each round. 

Edit UJin11ows 

Party Status 

Run 

Fred 

Barney 
Bam Bam 

Betty 
Wilma 

Pebbles 

Monsters 
2 Skeletons 

Fighting 
Fighting 
Fighting 
Avoiding 
Avoiding 
kat 

Attack 

To choose the action being taken by a character, press [Return] repeatedly 
until that character's action box is highlighted. Then type in the desired action 
and press [Return] to enter it. You may also type just the initial letter or letters 
of the command. 

Edit Windows 

Party Status 

Run 

The possible actions are: 

Fred 
Barney 

Bam Bam 
Betty 

Wilma 
Pebbles 

Fighting 
Fighting 
Fighting 
Avoiding 
Avoiding 
KATINO 

Attack 

• Fight the monsters. To do this, you must be in the front rank of the 
party. You need only type [F] or [f] and press [Return]. 

•Avoid the monsters. Generally, you only do this if there is nothing the 
character can do to help. Avoiding reduces the chance that the monsters 
will be able to attack you . You need only type [A] or [a] and press 
[Return]. 

• Dispel! the monsters. Some monsters in the Maze, collectively termed 
"The Undead," are animate only through the power of great Evil. These 
monsters can sometimes be forced from the normal planes of existence 
back to the abyss from which they were summoned by taking a deep 
breath and Dispelling the little devils. 

All Priests, ·and certain Bishops and Lords, have the ability to Dispel! 
monsters. They do this with varying degrees of effectiveness, depending 
on the viciousness of the monsters, and on how well-heeled the spell ­
caster is. If your character has this power, you need only type [D] or [d] 
and press [Return]. 



• Cast a spell. Remember that characters can only cast spells they 
know and must have spell points remaining at the appropriate level. Type 
the fi;st few letters of the spell, enough to distinguish it from other names 
then press [Return]. At this point the full spell name will appear to confirm 
your order, unless th8re's a problem with spell points or knowledge. When 
you know a lot of spells, it's important to spell carefully! 

• If you cannot remember what spells you can throw, a special spell 
search command will help you search for the right one. Each time 
you press xS, the action box will display another combat-worthy 
spell that you know, and have a spell point available for casting. The 
sequence of spells is identical to that found in the spell books, 
except that anything you can't throw will be skipped. 

• Use an item. Certain items can be used to cast magical spells. The 
use of such items does not require any spell knowledge, or cost you any 
spell points. Potions may be used only once, while Scrolls and Wands will 
last for roughly twenty uses before they are exhausted. If you know which 
position the spell-casting item has on your items list, type the number 
(from [1] to [8]) and press [Return]. The action box will then display the 
name of the equivalent spell. 

• If you don't know the item's number in the list, type xl to search 
for an item with magical powers. Each time you press x I the search 
will resume. 

A short-cut: If you're choosing F)ight, A)void, or D)ispell, you can use the [x] 
key to mean "enter this letter, and then press [Return] for me". In other words, 
holding down the [x] key and pressing [F] does the same thing as pressing [F] 
followed by a [Return]. Finally, since the text boxes are standard Macintosh 
user-interface text areas, all the usual selection and control techniques will 
work. 

Once you have made your selections, click Attack, and the computer will 
mediate the combat round. Through the three windows on your screen, you'll 
learn about the progress of the fighting, including casualties on both sides. 

E dl1 UJlndows 

Party Status 
9/9 
9/9 
6/9 
9/9 

11/11 
9/9 

Fred : Fight which group of monsters? 

Sometimes, one of your characters will have a choice of which monster group to 
attack, and you'll be asked to select a target. Simply type the number of the 
unlucky monster group as it appears in the Monsters window ([1] through [4]}, 
or click on the monsters' name or icon. The same procedure applies when you 
need to select a character as the recipient of a spell. 

• If the combat messages are going by too slowly, holding down the 
[Option] key will make them go faster. After the combat, you may want to 
reduce the delay time, using the Options menu. 

• Occasionally you will surprise the monsters. If this happens, you are 
entitled to a free round of attacks, with the restriction that you cannot cast 
spells. Your other sure-fire option is to Run away -- guaranteed to work if 
the monsters were surprised by you. Needless to say, sometimes the 
party will be ambushed, which has far less pleasant effects. 

• Certain peaceful monster types may offer your party a truce. If you 
agree, the monsters will politely scram, letting you go about your business. 
If you refuse a truce, however, you'll surely have a fight on your hands. 
Remember: Monsters, like adventurers, may be inclined either toward 
Good or Evil. Strange things have been known to happen to those who 
respond innappropriately to peaceful overtures in the Maze ... 



When all of the sounds of battle have died down, th_e Events & ln~t.ructions 
window will show you how many Experience points eac~ surviving p~rty 
member will be awarded for his or her brave conduct. You don tear~ any points 
for monsters who run away or for dispelling monsters. You'll also find out how 
many gold pieces each char~cter e8:rns. ~egrettably, some groups of m~nsters 
are security-conscious, and like to hide their money and other valuables 1n ... 

You haue found a chest. Here is what 
eueryone thinks they see. 

Open Chest 

Leaue Chest 

Treasure Chests 

The Treasure Chest display pops up at the end of an encounter if the 
monsters were guarding a chest. These little babies may be easy to pry open; 
on the other hand, they may be booby-trapped in such a way as to harm the 
person opening them. You'll see a list of all the fairly-healthy characters in yo~r 
party on the left; on the right is a list showing what each character thinks .1s 
protecting the chest lid . Some characters will think they see f:'lo Trap, while 
others see a Poison Needle, a Mage Blaster, or other implements of 
destruction. 

Party members whose names appear in boldface are Thieves and Ninjas, who 
are experts in these matters. Their opinions are to be highly regarded. Names 
which are in italics are those of party members who can cast Caito spells to help 
identify the nature of the trap, if any. 

If someone in your party can cast a Caito, click on his or her name and then click 
on the Cast Caito button. To the right of the caster's name will appear their 
spell-enhanced image of what's on the chest. If no Caito casters are available, 
go on to the next step. 

Pick a boldface character, if you have one, to open the chest; click on his or her 
name from the left-hand list. Then pick a character who thinks he or she sees 
something nasty on the chest and click on the nasty thing from the right-hand 
list. The idea is that this character is "pointing out" the trap he or she sees to the 
chest-opening character. Finally, click on the Open Chest button and stand 
back! 

If the chest had no traps, or if you correctly identified the trap and succeeded in 
disarming it, you'll generally get all the goodies inside without any trouble. 
However, if you fail, or mis-diagnosed the problem, whoever attempted to 
Open the chest will be injured! Some traps, such as the dreaded Gas Bomb, 
can also harm the "innocent bystanders" in your party. 

Of course, you may chicken out and decide not to try opening the chest, in which 
case you can click on Leave Chest. Too bad. 

Lowering your Insurance rates 

The first rule of the successful Wizardry player is "He who turns and runs away, 
lives to run another day." Don't be ashamed to run from encounters where the 
monsters have the upper hand. When first starting out, run back to the Castle 
often (even after each encounter) to rest, replenish your spells, and heal your 
wounded. Never go deeper into the dungeon until you are quite comfortable on 
the current level. Avoid the temptation to take on "Just one more encounter." If 
your characters become poisoned, and you don't have magical means to cure 
them, run for the Castle as fast as you can! 

• HINT: Use your spell-casting characters wisely. When you are fighting 
your first few groups of monsters, cast a KATINO spell, knocking out the 
opposition so that you'll have plenty of leisure time in which to slit their 
throats. Naturally, this will not work against certain monsters, and you'll 
have to run away from these creatures until you become more powerful. 



Magic 
The acquisition and careful use of MAGIC spells and items is of paramount 
importance to the successful adventurer. In certain situations, a good dose of 
magic can be worth almost any price. 

Magical items range from potions and scrolls with limited effects to some of the 
most powerful artifacts known. Some can actually be bought in the Trading Post 
as readily as your grocer sells you a box of macaroni-and-cheese dinner mix. 
But most of the really important ones are found only after many hair-raising 
adventures in the depths of the Maze, and are usually guarded by fearsome 
monsters who dislike the cut of your jib. 

Magic items may do many things. Generally they will do one or more of the 
following: 

• Cast a spell, or have magical abilities you may invoke 

• Alter Armor Class 

• Change fighting ability 

• Protect against certain monsters, or be helpful in killing them 

• Be usable only by certain character classes 

When magical items are first discovered in the Maze, their true nature is not 
known. Only Bishops, and the Trading Post, can Identify them. Even so, some 
items may have hidden qualities. And a few items are, let's face it, Cursed. 
When you have a cursed item in your possession and you Equip yourself with it, 
you will be stuck with it! This often has detrimental consequences, especially 
when your sword decides not to fight any more in the middle of a brawl. 

While some items have the ability to throw spells, most spell-casting is done by 
Mages, Priests, and the like. There are a total of fifty spells, divided into Mage 
and Priest categories. Each category is further divided into seven levels of 
power, with the most potent spells at the higher levels. Spells can be cast only 
through the solemn utterance of a "power word," which you'll select from a list or 
enter at the keyboard. 

Following is a complete description of all the spells used in Wizardry. For each 
spell, we've given you the name, a rough translation, the power level, where it 
can be cast, the area of its effect, and a brief description of its effects. 

Mage Spells 

Level 1 Mage spells 

Spell Name HALITO 
Translation LITTLE FIRE 
Spell Level 1 
Spell Type COMBAT 

Area of Effect 1 MONSTER 

Spell Name MOGREF 
Translation BODY IRON 
Spell Level 1 
Spell Type COM BAT 

Area of Effect CASTER 

Spell Name KATINO 
Translation BAD AIR 
Spell Level 1 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Spell Name DUMAPIC 
Translation CLARITY 
Spell Level 1 
Spell Type PEACETIME 

HALITO causes a flame ball about the 
size of a baseball to strike a monster, 
inflicting from one to eight hit points 
of damage. 

MOGREF reduces the spell-caster's 
AC (Armor Class) by two points. The 
effects last for the entire encounter. 

KATI NO causes most of the monsters 
in a group to fall asleep. KATINO only 
affects normal animal or humanoid 
monsters, and the duration of its 
effect is inversely proportional to the 
power of the monster. Sleeping mon­
sters are easier to hit, and successful 
strikes do double damage! 

DUMAPIC grants you insight into your 
party's position in the Maze: the exact 
displacement from the stairs leading 
to the Castle (vertically, North, and 
East), and the direction you're facing. 



Level 2 Mage spells 

Spell Name OIL TO 
Translation DARKNESS 
Spell Level 2 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Spell Name SOPIC 
Translation GLASS 
Spell Level 2 
Spell Type COMBAT 

Area of Effect CASTER 

Level 3 Mage spells 

Spell Name MAHALITO 
Translation BIG FIRE 
Spell Level 3 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Spell Name MOLITO 
Translation SPARK STORM 
Spell Level 3 
Spell Type COM BAT 

Area of Effect 1 GROUP 

OIL TO causes one group of monsters 
to be enveloped in darkness, which 
reduces their ability to defend them­
selves against your attacks. 

SOPIC causes the spell-caster to 
become transparent. This makes him 
or her harder to see; thus the caster's 
AC is reduced by four points during 
the encounter. 

MAHALITO causes a fiery explosion 
to erupt amid a monster group, doing 
four to twenty-four hit points of 
damage. As with other similar spells, 
monsters may be able to minimize 
the damage done. (Note the "MA-" 
prefix, meaning "big.") 

MOLITO causes sparks to fly about 
and damage about half the monsters in 
a group, to the tune of three to 
eighteen hit points. The monsters 
have no chance of avoiding the sparks. 

Level 4 Mage spells 

Spell Name MORLIS 
Translation FEAR 
Spell Level 4 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Spell Name DAL TO 
Translation BLIZZARD BLAST 
Spell Level 4 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Spell Name LAHALITO 
Translation FIRE STORM 
Spell Level 4 
Spell Type COMBAT 

Area of Effect 1 GROUP 

Level 5 Mage spells 

Spell Name MAMORLIS 
Translation TERROR 
Spell Level 5 
Spell Type COMBAT 

Area of Effect ALL MONSTERS 

Spell Name MAKANITO 
Translation DEADLY AIR 
Spell Level 5 
Spell Type COMBAT 

Area of Effect ALL MONSTERS 

Spell Name MADAL TO 
Translation FROST KING 
Spell Level 5 
Spell Type COMBAT 

Area of Effect 1 GROUP 

MORLIS causes one group of monsters 
to fear the party greatly. The effects 
are the same as a double-strength 
DILTO spell. 

DAL TO is similar to MAHALITO except 
that extreme cold replaces flames. 
In this case, anywhere from six to 36 
points of damage are inflicted. 

LAHALITO is an industrial-strength 
MAHALITO . . . quite the flamethrower 
for those extra-irksome monsters. 
LAHALITO will inflict from six to 
36 hit points of damage. (The "LA-" 
prefix signifies "great.") 

MAMORLIS is similar to MORLIS, in 
that it causes monsters to be gripped 
by an incapacitating fear of the party. 
The difference is that all monster 
groups are affected by it. 

Any air-breathing monsters of less 
than eighth level (i.e., having no more 
than 35-40 hit points each) are killed 
outright by this spell. More potent 
creatures are not as impressed by it. 

MADAL TO is a supercooled DAL TO, 
causing eight to 64 hit points of 
damage. All monsters suffer from it, 
to some degree. 



Level 6 Mage spells 

Spell Name LAKANITO 
Translation SUFFOCATION 
Spell Level 6 
Spell Type COM BAT 

Area of Effect 1 GROUP 

Spell Name ZILWAN 
Translation DISPELL 
Spell Level 6 
Spell Type COMBAT 

Area of Effect 1 MONSTER 

Spell Name MASOPIC 
Translation BIG GLASS 
Spell Level 6 
Spell Type COMBAT 

Area of Effect ENTIRE PARTY 

Spell Name HAMAN 
Translation BEG & GROVEL 
Spell Level 6 
Spell Type COMBAT 

Area of Effect UNKNOWN 

All monsters in the group subjected 
to this spell die. But if they do not 
depend on air, or if they're especially 
magic-resistant, you're in trouble. 

This spell will destroy any one 
monster of the Undead variety. 

This spell duplicates the "trans­
parency" effects of SOPIC for the 
whole party. Each party member's 
AC is reduced by four points for the 
duration of the encounter. 

This spell is indeed terrible, and may 
backfire on the caster. Thirteenth­
(or higher) level characters may cast 
it, but doir.g so will drain them of one 
level of experience. The effects of 
HAMAN are strange and wonderful. 

What happens when you stutter during spell casting 
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Level 7 Mage spells 

Spell Name MALOR 
Translation TELEPORT 
Spell Level 7 
Spell Type ANY TIME 

Area of Effect ENTIRE PARTY 

This spell's effects depend on the 
situation in which the party finds 
itself when it is cast. MALOR will 
teleport the entire party from one 
location to another. 

More about MALOR. When used in the heat of battle, MALOR's effects are 
rand~m., although Y.ou will not be teleported away from the current Maze level. 
Casting 1t at othe~ times, when there 1s more chance for concentration, affords 
you the opportunity to move the party anywhere in the Maze. Be Warned 
however, that if you teleport yourself outside the Maze, or into an area that is 
solid rock, you will all be Lost forever, so this spell is to be used with great 
caution. Combat use of MALOR will not "rock" you. 

User-c;tirec.ted teleportation, available only in the r~lative tranquility of 
peacetime, involves three scroll bars. Each bar selects displacement in one of 
the three directic:_>~s (North/South, East/West, and up/down in the Maze) from 
y9ur current pos1t1on. The number of steps or levels you'll be moved when you 
click on the Teleportl button appears in the labels for each scroll bar. Using the 
Cancel button lets you change your mind, but that seventh-level spell point is 
already gone. 

Spell Name MAHAMAN 
Translation BESEECH 
Spell Level 7 
Spell Type COM BAT 

Area of Effect UNKNOWN 

Spell Name TIL TOWAIT 
Translation KA-BLAM! 
Spell Level 7 
Spell Type COMBAT 

Area of Effect ALL MONSTERS 

The same restrictions apply to this 
spell as do to HAMAN. However, the 
range of possible effects is even 
greater. This spell is generally used 
only when there is no other hope for 
survival. 

The effect of this spell may be 
likened to that of a small, well-con­
tained, nuclear fusion explosion. 
Luckily, the party is shielded from its 
effects. The monsters are not so 
lucky. This spell will wreak from ten 
to 100 hit points worth of havoc. 



Priest Spells Level 2 Priest spells 

Spell Name MATU MATU has the same AC-reducing 
Level 1 Priest spells Translation ZEAL properties as KALK!, but at double 

Spell Level 2 the strength -- i.e., AC is lowered by 
Spell Name KALKI KALK! reduces the AC (Armor Class) Spell Type COMBAT two points for everyone. 
Translation BLESSINGS of all party members by one point, Area of Effect ENTIRE PARTY 
Spell Level 1 and thus makes them harder to hit. 
Spell Type COMBAT Spell Name CALFO CALFO permits the caster to deter-

Area of Effect ENTIRE PARTY Translation X-RAY VISION mine the exact nature of a trap on a 
Spell Level 2 treasure chest 95% of the time. This 

Spell Name DIOS DIOS restores from one to eight lost Spell Type LOOTING spell may be used only when looking 
Translation HEAL hit points to a party member. It will Area of Effect CASTER at a chest. 
Spell Level 1 not bring the dead back to life. 
Spell Type ANY TIME Spell Name MANIFO MANIFO causes some of the monsters 

Area of Effect 1 PERSON Translation STATUE in a group to become stiff as statues 
Spell Level 2 for one or more melee rounds. The 

Spell Name BADIOS BADIOS causes from one to eight hit Spell Type COMBAT chance of success, and the duration 
Translation HARM points of damage to be inflicted on Area of Effect 1 GROUP of the effects, depend on the power of 
Spell Level 1 a monster, and may kill it. It is the the target monsters. 
Spell Type COMBAT reverse of DIOS. (Note the "BA-" prefix, 

Area of Effect 1 MONSTER which usually means "not.") Spell Name MONTINO MONTINO causes the air around a 
Translation STILL AIR group of monsters to stop transmitting 

Spell Name MILWA MILWA causes a softly glowing magic Spell Level 2 sound. As with MANIFO, various 
Translation LIGHT light to accompany the party, reveal- Spell Type COMBAT monsters will react differently to 
Spell Level 1 ing all secret doors (glimpsed only on Area of Effect 1 GROUP the spell. Monsters and Party mem-
Spell Type ANY TIME rare occasion without such aid). This bers under MONTINO's influence 

Area of Effect ENTIRE PARTY spell lasts only a short while. cannot cast spells, as they are unable 

PORFIC lowers the AC of the caster 
to utter the magic words! 

Spell Name PORFIC 
Translation SHIELD considerably. The effects last for 
Spell Level 1 the duration of combat. 
Spell Type COMBAT 

Area of Effect CASTER 



Level 3 Priest spells Level 4 Priest spells 

Spell Name LOMILWA LOMILWA is a MILWA spell that Spell Name DIAL DIAL is similar to DIOS (only better) , 
Translation MORE LIGHT lasts until the party returns to the Translation CURE and restores two to sixteen hit points 
Spell Level 3 Castle. Spell Level 4 to a party member. 
Spell Type ANY TIME Spell Type ANY TIME 

Area of Effect ENTIRE PARTY Area of Effect 1 PERSON 

Spell Name DIALKO DIALKO cures monster-induced Spell Name BA DIAL BADIAL inflicts two to sixteen hit 
Translation SOFTNESS paralysis, and removes the effects Translation WOUND points of damage to a monster. 
Spell Level 3 of MANIFO and KATI NO from one Spell Level 4 
Spell Type ANY TIME member of the party. Spell Type COMBAT 

Area of Effect 1 PERSON Area of Effect 1 MONSTER 

Spell Name LATUMAPIC LATUMAPIC makes it readily apparent Spell Name LATUMOFIS LATUMOFIS makes a poisoned person 
Translation IDENTIFICATION exactly what the opposing monsters Translation CURE POISON fit and whole again. (Note that poison 
Spell Level 3 are. This spell lasts until the party Spell Level 4 causes a character to lose hit points 
Spell Type COMBAT returns to the Castle. Spell Type ANY TIME steadily during movement and combat) . 

Area of Effect ENTIRE PARTY Area of Effect 1 PERSON 

Spell Name BAMATU BAMATU reduces the AC of each party Spell Name MAPORFIC MAPORFIC is an improved PORFIC, 
Translation PRAYER member by four points, for the Translation BIG SHIELD with effects that last for the entire 
Spell Level 3 duration of combat. Spell Level 4 expedition. 
Spell Type COMBAT Spell Type ANY TIME 

Area of Effect ENTIRE PARTY Area of Effect ENTIRE PARTY 

How not to open a chest 



Level 5 Priest spells Level 6 Priest spells 
Spell Name DIALMA DIALMA restores three to twenty-

, Spell Name LORTO Translation BIG CURE four hit points of damage sustained LORTO causes sharp blades to slice 
Spell Level 5 by a character. (Note the "-MA" Translation BLADES through a group, causing six to 36 
Spell Type ANY TIME suffix, meaning "greatly.") Spell Level 6 points of damage. 

Area of Effect 1 PERSON Spell Type COMBAT 
Area of Effect 1 GROUP 

Spell Name BADIALMA BADIALMA inflicts three to 
Spell Name Translation BIG WOUND twenty-four hit points of damage. MADI MADI causes all hit points to be 

Spell Level 5 Translation REGENERATION restored and cures any condition 
Spell Type COMBAT Spell Level 6 but death. 

Area of Effect 1 MONSTER Spell Type ANY TIME 
Area of Effect 1 PERSON 

Spell Name LITOKAN LITOKAN causes a pillar of flame to 
Spell Name MA BA DI Translation FLAME TOWER strike a group of monsters, doing MABADI causes all but one to eight 

Spell Level 5 three to twenty-four hit points of Translation MAIMING hit points to be removed from the 
Spell Type COMBAT damage to each. As with many spells Spell Level 6 target. 

Area of Effect 1 GROUP affecting entire groups, however, Spell Type COMBAT 
there's a chance that individual mon- Area of Effect 1 MONSTER 
sters will be able to evade or mini-

Spell Name mize its effects. And some monsters LOKTOFEIT LOKTOFEIT causes all party members 
will be resistant to the spell. Translation RECALL to be teleported back to the Castle 

Spell Level 6 minus all their equipment and most 
Spell Name KANDI KANDI allows the user to locate char- Spell Type COMBAT of their gold. There's also a good 
Translation LOCATION acters in the Maze. It tells on which Area of Effect ENTIRE PARTY chance that this spell will not work. 
Spell Level 5 level, and in roughly what area, the 

Level 7 Priest spells Spell Type PEACETIME person may be found. 
Area of Effect 1 PERSON 

Spell Name MALIKTO MALIKTO inflicts twelve to 72 hit 
Spell Name DI DI causes a dead person to be resur- Translation WRATH points of damage on all monsters. 
Translation LIFE rected. The renewed character has Spell Level 7 None can escape or minimize its 
Spell Level 5 but one hit point. Also, this spell is Spell Type COMBAT effects. 
Spell Type PEACETIME not as safe or effective as using the Area of Effect ALL MONSTERS 

Area of Effect 1 PERSON Temple. 
Spell Name KADORTO KADORTO restores the dead to life 

Spell Name BADI BADI treats the affected monster Translation RESURRECTION as does DI (with the same drawbacks). 
Translation DEATH to a coronary thrombosis. It may or Spell Level 7 KADORTO, however, restores all hit 
Spell Level 5 may not cause death to occur. Spell Type ANY TIME points, and even works on characters 
Spell Type COMBAT Area of Effect 1 PERSON who have been reduced to Ashes. 

Area of Effect 1 MONSTER 



Appendices 
The Wizardry Menus 

Rbout Wizardry ..• 
Wizardry Statistics ••. 
Wizardry Screen Sauer 
Close desk accessories 

Desk Rccessories 

In addition to the usual desk accessories, the a menu provides the following 
features: 

•About Wizardry ... is the Wizardry title and credits page. 

• Wizardry Statistics ... displays a page of handy statistics about your 
playing history. 

• Wizardry Screen Saver is useful when you have to leave your 
Macintosh alone for awhile. It inverts the screen image every 30 seconds, 
ensuring that no "dot burn-in" occurs on your monitor. The screen saver 
feature is automatically invoked if you do nothing with the mouse or 
keyboard for more than a few minutes. 

• Close desk accessories closes all active desk accessories. 

Desk accessories work as you would expect, with one restriction. If you are 
using desk accessories while playing Wizardry on a 128K Macintosh, you will 
be unable to continue the game until all the accessories are closed. When you 
open the first desk accessory, most of the menu items will grey out to remind 
you of this restriction. 

Transfer characters ••• 
Backup characters .•• 
Restore characters from backup ... 
Store default desktop 
Restore default desktop 

Print character reference sheets ••• 

Quit 

The File menu controls all disk-related functions of the game. It allows you to: 

• Transfer characters ... from one duplicate Scenario disk to another. 
You cannot transfer characters to a full Roster, or transfer anyone to a 
Roster which already contains a character of the same name. Characters 
to be moved must be alive and in the Castle. 

• Backup characters ... from the Roster to a small file, especially 
established for this purpose, on a disk. It's a good idea to do this fairly 
often in case somethin9 catastrophic happens to your Scenario disk(s). If 
more than one person 1s playing Wizardry, you can also use this feature 
to allow each user to have a complete set of 20 characters. The entire 
contents of the Roster will be backed up as a unit. You may set up backup 
files on Scenario disks, or on a separate disk for added security. 

• Restore characters from backup •.. replaces the entire Roster with 
the contents of the backup file you select. Note that this will wipe out 
any characters currently in the Roster! 

• Store default desktop stores the current screen positions of windows 
and application icons. The next time you start the game, the desktop will 
come up in this exact state. Thus, if you don't like our display setup, you 
can devise an arrangement you prefer and store this as your default. 

• Restore default desktop restores the windows and application icons 
to the positions they were in when you last used Store default desktop. 

• Print character reference sheets •.. allows you to print handy 
listings of any character(s) in the Roster, one chpracter per page. 

• Quit exits the game. You can also quit by double-clicking on the Quit 
icon, which you will find hidden under the Roster window. 



Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 

The Edit menu contains the standard "Undo/Cut/Copy/Paste/Clear" items. 
Wizardry fully supports cut-and-paste options where appropriate. 

Game hints, Sir-tech 
6 main street, 
Ogdensburg, NY 13669 
[315) 393-6633 

Hints hotline til Bpm EST 
On weekends til Spm EST 

The Help menu does nothing but list the address and phone number of the 
Sir-tech hints hotline. 
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First character in party 3€F 
NeHt character in party 3€N 
All characters in party 3€A 
Alternate window arrangement 

Party Window 
Roster Window 
Maze Window 

Remoue player windows 

3€P 
3€R 
3€M 

The Windows menu contains options that let you control the game's windows. 

• First character in party (:icF) selects the first character icon in the 
Party window, opens his or her information window (if not already open) 
and brings the window to the front of the desktop. 

• Next character in party (:icN) checks to see which character's 
information window (if any) is frontmost on the desktop. It then selects the 
next character in the Party window, opens the information window for it, if 
not already open, and brings it to the front of the desktop. 

•NOTE: If no character windows are open, Next character in 
party and First character in party are equivalent. 

·All characters in party (xA) opens windows for all party members, 
closes windows for characters not in the party, and organizes the windows 
neatly. 

• Alternate window arrangement moves all the open windows of 
party members to the bottom of the screen, and arranges them so that 
only the first line of their information displays is visible. This arrangement 
is useful when exploring the Maze. 

• Party window (x P}, Roster window (xR), and Maze window (xM) 
bring the indicated windows to the front of the desktop. 

• Close player windows closes all previously opened player windows. 

In addition to the listed options, holding down the x key and pressing [1 ], [2], 
[3], [4], [5] , or [6] will open the information window for that numbered character 
in the party (if not already open) and bring the window to the front of the 
desktop. 



Dump swag bag l!CD 
Saue party state l!CS 
Mark location l!CL 
Enlarge maze window 
Disband party 
Diuuy gold 

No message delay 
Half second delay 
1 second delay 

../2 second delay 
5 second delay 
Continue button 

The Options menu contains some useful options and conveniences: 

•Dump Swag Bag (ooD) drops all the items in the Swag Bag. You'll be 
asked 1f you really want to do this. 

•Save party state (ooS) ensures that all current party status 
information has been written back to disk. (Wizardry automatically does 
this every 3 minutes.) 

• Mark location (ool) places a mark on the floor of the Maze at your 
current position. This option is useful for mapping. 

• Enlarge Maze window makes the Maze window twice as big. This 
menu item then becomes Reduce Maze window. 

• Disband party moves all characters from the party back into the 
Roster, and removes their windows from the desktop. This option works 
only in the Castle (when the Roster is visible). 

• Divvy gold combines the gold of all the party members, and then 
divides it equally among them. 

•The No message delay, Half second delay, 1 second delay, 2 
second delay, 5 second delay and Continue button settings 
determine the length of time messages remain on the screen. Selecting 
Continue button will force Wizardry to ask you if it is okay to continue 
after each message. If you want Wizardry to skip any delay that it is 
performing, hold down the [Option] key. 

Restart a party •.. 
Rename a character ••. 
Design guildmasters insignia ... 

The Utilities menu contains three essential utilities: 

• Restart a party ... lets you resume an e.xpedition you interrupted 
during a previous session by Quitting. You will. be asked for the nam~ of 
one of the party members OUT in the Maze. This character must be alive. 
You'll be transported to that character's last known location in the M.ai:e. 
The other par:tY members will be close a; hand. The. party may not be m its 
original marching order, and any protective spells will have worn off. 

• Rename a character ... lets you change the name of a character. 
The new name cannot exceed fifteen typed characters in length (letters, 
numbers, and spaces). 

• Design Guildmaster's insignia •.. lets you customize the icons of 
certain adventurers. The highest-level characters of each clas~ are ;he 
Guildmasters. These characters are accorded several honers, including 
this "award of arms." Characters must have attained the 7th level of 
experience before they can become Guildmasters. 



Short-cuts 
Almost everywhere in the game, the keyboard can be used as a substitute for 
the mouse. 

• Whenever you see a button surrounded by a darker border, you can 
press (Enter] or [Return] to choose that button's action. 

• When presented with a YES/NO decision box, you can press (Y] for yes 
or [N] for no. Note that the NO button has a dark border around it, so 
(Return] and [Enter] mean NO. 

Just because you're paranoid ... 
Do not assume that we have told you about everything in the game. We feel that 
part of the fun of Macintosh Wizardry is finding all the interesting features and 
short-cuts that we have managed to hide here and there. So feel free to 
experiment and find out where the hidden goodies are. 

• If you find one, that means that we did a good job anticipating the things 
we thought you might try. 

• If you do something unusual, and nothing happens, then maybe you 
have thought of a feature that should be in the game, but isn't. Tell us 
about it, and if it is reasonable and do-able, we may add it. 

Glossary of terms 
Age : As adventuring in the Maze is definitely a young person's game, 
characters over the age of 50 will gradually become more feeble until they must 
be retired, with full benefits, by the player. 

Alignment: A character's ethical bent; either Good, Neutral, or Evil. 

Armor Class: The degree of protection from attack enjoyed by an adventurer. 

Castle: The center of activity in the game. The Hotel, Temple, and Shop are 
located in the Castle, the Training Grounds are nearby, and the entrance to the 
Maze is situated directly underneath. 

Character: One of up to twenty "actors" through whom you live out an 
adventure. Each character has unique capabilities, strengths, and weaknesses, 
partly determined by the player, partly by luck, and partly by experience. A 
group of up to six characters adventuring together make up a party. 

Class: A character's occupation. Classes include Fighter, Mage, Priest, Thief, 
Bishop, Samurai, Lord, and Ninja. 

Death : What happens to a character when his Hit Points go to zero. In 
Wizardry, death may be only a temporary inconvenience. 

Equip(ping) Items: The process of placing some of a character's own items 
in a position to be used during combat. 

Experience points: A numerical representation of a character's proficiency. 
Party members surviving fights with monsters earn experience points based on 
the nastiness of their opponents. When a character accumulates enough 
experience points, he may become more powerful by reaching a higher level. 

Gold: The currency in circulation in and around the Castle. 

Guildmaster: The character who has attained the highest experience level 
within any given Class. Must be of the seventh experience level or higher. 
Guildmasters are accorded several special powers: 

• When attacking monsters, they have a 5% better chance of hitting their 
targets, and may be granted an extra round of attack. 

·Their Armor Class rating is reduced by one point. 

• They are granted one extra spell point per Mage or Priest spell level. 

• They may custom-design their own insignia. 



Hit Points: The amount of damage a character can sustain before death. 

Identify (an Item}: Determine the true nature of an item. Bishops can 
perform this function without charge; Boltac will help you out for a modest fee. 

Item: An obj.ect carried o~ found by characters. Items include weapons, armor, 
~nd oth~r things, with which characters may or may not equip themselves from 
time to time. lte.ms may be traded ~mong characters using the Swag Bag, or 
bought and sold in the Shop. Some items have magic properties. 

Level: The word "level" has three distinct meanings in Wizardry. 

• Characters' level of ability gradually rise with experience. 

• Spells have seven different power levels. 

• The Maze has several floor levels. 

Map: What every adventurer needs to negotiate the corridors of the Maze. 

Master Dis~: The disk included in the Wizardry package. You never play on 
the Master disk. Instead, you make a copy of it (called the Scenario Disk) and 
play on the copy. 

Maze: The system of underground passageways in which the adventure takes 
place. The party travels through the Maze in search of adventure loot and 
immunity from Federal prosecution. The Maze is displayed in 3-D perspective. 

Monsters: Creatures f.ound in the Maze, usually hostile to members of your 
party. Monsters travel in groups, as your characters do, and sometimes guard 
Treasure Chests. 

Party.: .A group of up to six characters assembled from the Roster for an 
exped1t1on. Party members must be of compatible alignment. 

Pool(ing} Gold: Assigning all the gold held by the party to a single character. 

Race.: A character belongs to one of 5 races: Human, Elf, Dwarf, Gnome, or 
Hobbit. See also Class. 

Roster: The field of characters from which several may be selected to 
adventure together. Up to twenty characters may remain on the Roster. 

Scenario: One of several Wizardry games, each with different story lines. 
This scenario is called Proving Grounds of the Mad Overlord. 

Scenario Disk: A copy of the Master disk which you must make to play the 
game. 
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Spell: A magic formula used to invoke supernatural aid. Certain character 
classes are particularly adept at learning to use these. 

Spell points: A character's available "throws" for each type and level of spell. 

Status: A description of what condition your characters are in. 

swag Bag: Handy sack into which party members can drop excess items. 

Trap: One of a number of nasty gadgets that can be attached to treasure 
chests. 

Treasure: Gold and valuable items found in the Maze, always guarded by 
monsters. 

:rreasure Chest: A sealed box guarded by monsters, containing gold and 
1te~s. May be hard to open; may not treat you very nicely if and when you do 
get 1t open. 

You: Have reached the end of the manual. Congratulations! Now go have 
some fun! 
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